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1. Introduction 

 
The purpose of the Softcopy Exploitation Tool (SOCET SET®) software is to support 
imagebased softcopy applications such as map-making, mission rehearsal, and photo-
interpretation. 
SOCET SETgenerates databases and products such as Digital Terrain Models (DTM), 
reports, vector databases, orthophotos, image maps, and image mosaics. SOCET SET 
supports a wide variety of applications, including: 

 Populating a GIS database (vector or raster) 
 Producing image maps 
 Civil engineering 
 Mission planning 
 Targeting 
 Mission rehearsal 
 Sensor research and development 

The SOCET SET software consists of over sixty application functions that can be 
chained together to form a processing flow that inputs imagery, performs the requisite 
analysis, and produces the final hardcopy or softcopy products. This User’s Manual 
describes the application functions in detail, including the following: 

 Data import capabilities for imagery, feature, and terrain data 
 Automatic extraction of Digital Terrain Model (DTM) elevation data 
 Interactive graphical editing of DTM data 
 Interactive two and three-dimensional feature data extraction 
 Orthophoto generation 
 Perspective scene generation 
 Point positioning, three-dimensional mensuration, and targeting 
 Image mosaicking 
 Image enhancement 
 Data export functions for softcopy databases (imagery, feature, and terrain 

data), and hardcopy products (image maps) 
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2. Typical Product System Flow 

 
Imagery is input to SOCET SET from either a digital softcopy source, such as SPOT or 
Landsat, or by scanning film-based imagery. The workstation products are in either 
softcopy format (such as DTMs, vector databases, orthophotos, etc.) or hardcopy format 
(such as image maps or photorealistic perspective scenes). 
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3. Using Aerial Photographs 

 
Frame and Panoramic 

Frame and Panoramic Import allow you to use digitized 
camera images in SOCET SET. 

 
Overview 

 
Frame Import reads a digitized frame camera image or a panoramic into SOCET SET. A 
frame image is a digitized version of a photograph taken by a frame or panoramic camera. 
A frame camera is a conventional camera with simple projective geometry. Most cameras, 
including surveying cameras and reconnaissance cameras, are frame cameras. A 
panoramic camera can be imported and is modeled as a cylinder. If the image you want 
to import is not a frame or panoramic image, you should use one of the other import 
modules: SPOT Import (for SPOT imagery), Landsat Import (for Landsat imagery), or 
Image Import/Reformat (for imagery with an unknown Math Model). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

When to Use Frame or Panoramic 
 

Frame Import 
Importing imagery is usually the first thing you do after creating a project. 
After importing a frame image, you typically perform Interior Orientation (if it was not 
done during the scanning process) and then control the image using Triangulation. After 
the image is controlled, you can utilize any extraction application, such as Feature 
Extraction or Terrain Extraction. If you have corrupted or lost your frame support file, 
you can recover it by importing the same way as you originally did and click Reuse 
when prompted that the image file exists. If you used “Image and Support” when you 
originally imported, use “Image and Support” again to re-create the support file.  
Frame Import can do several things for you, some of which are: 
 

a Reformat or copy the input image to the standard SOCET SET directory or 
format (to improve image access time)  
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b Creates a support file containing the frame math model parameters; and  
c Places the image into a Project file structure so it is known to SOCET SET 

and is available for subsequent tasks. 
d Minify the image to create the reduced resolution images.  

 
To use Frame Import, you must have the input image stored as a disk file available to 
SOCET SET. The input image format may be any sort of raster image; however, if you 
are importing a plain-raster image, you must select the Image and Support option of 
Frame Import if you wish it to be minified or displayed on Main Workstation Windows. 
 

 If the input image file is on tape, you must copy it from tape to disk before 
running Frame Import. 

 If the input image is on film, you must digitize or scan the image before 
running Frame Import. 

 
Panoramic Imagery 
If your frame image is a panoramic aerial photograph, you should use Panoramic Import. 
Panoramic Import creates a model with compensation for sensor movement. 
 
User Interface 
The inputs to Frame Import include raster image files and image support data. The input 
image can be of any SOCET SET supported type (See “Data Import and Export,” 
Chapter 15 for types) including types from the LHS Scanner. If the format is plain raster, 
the first N bytes correspond to the N pixels in the first line of the image, from upper-left 
to upper-right corners; the next N bytes are the pixels in the second line, and so forth. 
 
The image support data can consist of triangulation data (camera position,  attitude, focal 
length), scanned photo data (image dimensions and photo to image transformation data), 
camera calibration data (camera fiducial coordinates, lens distortion data, principal point 
offset), and PATB, ALBANY or BINGO triangulation results data. These may come in 
file formats for certain supported input types, or may be entered by keyboard. 
 
You should supply the name of a camera calibration file. Creating a camera calibration 
file is described fully in the Utilities chapter. See “Camera Calibration Editor” on page 
54-5. 
If you are importing JPEG compressed images, move the images and support files (if 
any) to the directory you will be keeping them in permanently before running Frame 
Import. Then import them using the “Support Only” option. Otherwise the images will be 
written to the new location as un-compressed images. 
 
Orientation Angles 
One of the key inputs to the frame import process is camera orientation. This is generally 
expressed as three angles such as omega, phi, and kappa but may be expressed in many 
ways. 
 
Frame Import allows the orientation to be imported in the following ways: 
1. You enter Omega, Phi, Kappa in the camera position table. These angles are defined 

in the “Manual of Photogrammetry” and are the sequential rotations from ground 
coordinates to image coordinates—more on these later. You may enter Heading, 
Pitch, Roll in the camera position table. These angles are sequential rotations from 
ground coordinates to image. The orientation angles may be provided in the 
documentation accompanying the photo. In this case you must enter the data in the 
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Frame Import window. If the orientation angles are not in one of the supported 
formats, you must convert them. 

2. The orientation angles may be included in triangulation file such as from ALBANY, 
BINGO, PATB, or a plain text file. See below for the format of a text file. 

3. If the orientation angles are not provided with the photo, you can have SOCET SET 
compute the orientation for you automatically during the Triangulation process. To 
do this, leave all entries in the Camera Position table at their default values. 

4. If the orientation angles are not provided with the photo, you can estimate the 
camera azimuth and obliquity by simply looking at the photo, then enter the heading 
and roll angles as described below. See “Estimating the Orientation Angles” on 
page 8-5. 

 
Omega, Phi, Kappa 
These angles define a transformation  
from ground space into fiducial (film) 
space. These angles are not as intuitive as 
heading, pitch, and roll, so you should 
avoid using omega, phi, kappa unless 
you have reason to use them. 
 
The three rotations are applied in the 
order omega, phi, kappa. Positive values 
are right-hand rotations. Omega is a 
rotation about the X (East) axis. Phi is a 
rotation about the once rotated ground Y 
axis. Kappa is a rotation about the twice 
rotated ground Z axis. 
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These orientation angles should not be confused with the alternative image-to-ground 
transformation, which may use the same notation. The following figure shows a Kappa 
for a vertical image. In this case omega and phi are approximately zero. 

 
Heading, Roll, Pitch 

These angles define a transformation from ground space to image space (fiducial or film). 
The three rotations are applied in the order heading, roll, then pitch. Heading is the 
azimuth angle from ground axis Y to film axis X normally the heading of the plane). It is 
positive clockwise from Y ground axis. The roll angle is about the once-rotated ground X 
axis (typically parallel to the fiducial X axis) and positive values are right-hand rotations. 
Pitch is positive (right-hand rule) about the twice-rotated ground Y axis. 
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Estimating the Orientation Angles 
Consider the situation when you have a digitized frame photo and you are preparing to 
run the Frame Import module. If you have the orientation angles and camera positions, 
then you should enter them during Frame import in the omega, phi, kappa format, or the 
heading roll, pitch format. Alternatively, you can select Unknown and solve for the 
angles during triangulation. As a last resort, you can estimate the orientation angles using 
the following steps. 
 
Heading - Looking at the photo camera X axis (fiducial X), estimate the heading (Red) 
from your ground Y axis. The ground Y axis is normally North (000). The heading angle 
should be between 0-360 degrees and is estimated from North clockwise to your assumed 
heading. The above diagram shows a heading of about 320°, the direction of flight.  
 
Roll - Estimate the roll angle. Picture the photo and plane aligned in fiducial x direction. 
If the plane were rolled to the right (as shown above), you have a positive roll angle. If 
you picture the plane rolled to the left, you have a negative roll angle. (Roll right is with 
the right wing down.) 
 
Pitch - The pitch is very hard to visualize and is usually set to zero. Pitch is again 
pictured as if the plane is pitching nose down (positive) or nose up (negative). 
 
 
Examples 
EXAMPLE A: You have a photo taken straight down, and the top of the photo is towards 
the NW. The roll and pitch are 0, and the heading is 45 degrees. 
EXAMPLE B: You have a photo obliquely taken toward the south-west. The fiducial x 
axis is toward the direction of flight (north-west). The photo appears to have a heading of 
320 degrees and a roll of about 30 degrees. Pitch is zero. 
 
Camera Mounting Angle (Panoramic only) 

EXAMPLE B
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Mounting omega, phi, and kappa are the angles of the sensor relative to the vehicle’s 
direction of flight. If all three angles are zero, the view is straight down at the center of 
the scan with the X coordinate (image samples direction) of the scan oriented along the 
line of flight. Omega is the left or right deflection. A sensor pointing to the left of the 
vehicle has a positive omega. Phi is the forward or backward deflection. A sensor 
pointing behind the vehicle has a positive phi. Kappa is the rotation in the vehicle’s 
horizontal plane. A sensor rotated counterclockwise has a positive kappa. 
 
Start and End Scan Angle (Panoramic only) 
Panoramic Import requires you to enter a start and end of scan angle. These angles are 
used to initialize the internal timing of the sensor model. By default, the scan direction is 
perpendicular to the direction of flight, with a positive angle to the left of the platform. 
The values are closely related to the interior orientation coordinates. The interior 
orientation must match the scan angles; i.e. if you enter non-symmetrical scan angles, 
then your IO coordinates must be non-symmetrical. For example if your start and end 
scan angles were 10 and 20 degrees, the interior orientation Y coordinates would be 100 
and 200. (The exact values for interior orientation depend on the camera parameters and 
scan rate.) 
 
Camera Position 
You have a choice of either entering a camera position during Frame and Panoramic 
Import or leaving the camera position as “unknown.” If you leave the images as 
unknown, you must run Multisensor Triangulation (MST) to control the images with 
ground control points. To make an image unknown with Frame Import, leave the X and 
Y boxes on the Camera Position / Orientation interface at 0.0. For Panoramic Import, the 
default is unknown and the position will remain unknown unless you select and fill out 
one of the camera position options under File > Camera Location pulldown. You can 
store position values in a text file (see below) and load them into the interface directly. 
 
Text File Input 
You can provide camera position and orientation angles for several images by creating a 
text file with one line of information in it for each image. The general format for each 
line is: 
 

ID X Y Z Omega Phi Kappa 
 
ID is the name of the image file or “dsup” file with the extensions stripped off. An 
alternate form is to put the strip and image number on each line: 
 

Strip_Number Image_Number X Y Z Omega Phi Kappa 
 

You may also omit IDs, strip and image numbers, or omega, phi, and kappa, for example: 
 

Strip_Number Image_Number X Y Z 
 
X Y Z Omega Phi Kappa 
 
ID X Y Z 

Values may be separated by spaces, tabs, or commas. Frame Import compares the values 
in the highlighted rows of the table with the values in the file. When it finds a match, the 
values are transferred from the file into the table. Be sure to highlight the rows you want 
to fill before importing the text file. If IDs, strip numbers and image numbers are omitted 
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in the text file, the values from the file are placed in the highlighted rows in the order 
they appear in the text file. 
 
Load your orientation text files into the application from the Frame Import window: 
 

1 Select the Review/Edit Settings button from the Frame Import window. 
2 In the Review/Edit Settings window, select the Camera Position/Orientation 

tab. 
3 Highlight rows of imagery files listed. 
4 Press the Read From File... button, and open your file. The x, y, z, 

Omega/Heading, Phi/ Roll, Kappa/Pitch columns in the Review/Edit 
Settings window will auto-populate with data. 

5 Press Close to accept. 
6 Continue with frame import in the Frame Import window. 
 

 
PAT-B File Input 
Frame Import can read exterior orientation from PAT-B files. Make sure your frame 
images (without file extension) are named the same as one of the items in the PAT-B file. 
For example if your image is named "6840154.tif", the PAT-B file must contain an item 
such as: 
 
 
 
 
A

 
 
Applanix File Input 

If you have an Applanix file which specifies your camera positions, you should select it 
with the “Read From File...” option. If your data is from a DSS system, use the 
“Applanix DSS EO data” option; otherwise use the “Applanix EO data“ option. The 
Applanix file is required to contain “POS/AV Computed Data at Camera Perspective 
Centre”, and each line of camera data must have exactly 11 columns. The name of each 
image file, without extension, must match the first column exactly. For example, if the 
image name is “12345.tif”, then the first column must be “12345”. If you choose to run 
Triangulation on the images, be sure to select the Applanix file in the Setup > Advanced 
> Airborne GPS option. 
 
ISAT File Input 
ISAT (Intergraph’s ImageStation Automation Triangulation) can be imported into 
SOCET SET. With SOCET SET project file information, the application uses the data 
from ISAT photo and camera files to generate support (.sup) files. The project file used 
for this triangulation import option should be in the LSR coordinate system. 
 
The following are steps to import ISAT data into SOCET SET: 

1 Select Preparation > Import > Image > Frame (the Frame Import window 
opens). 

2 RMB at Input Images and add... images to import. 
3 Set Camera Calibration to isat.cam. 
4 Make sure Digital Camera is checked. 
5 Click Review/Edit Settings... button. 
6 At Review/Edit Settings, select images to import. 
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7 Select Camera Position/Orientation tab. 
8 Click on Read From File and select ISAT file option. 
9 Select ISAT photo file. 
10 Close the Review/Edit Settings window. 
11 At Frame Import window, click Start. 

 
BINGO Frame Import 
BINGO Frame uses the interface as Frame Import. BINGO software is ideally suited for 
the adjustment of large blocks of Frame images. 
 
If the final desired mapping coordinate system is Geographic, it is recommended to first 
perform image import and triangulation under an interim Project using a coordinate 
system such as UTM. Then a new Project with Geographic coordinate system is created 
after and the contents of the interim project are then copied into the new project using the 
Project Copy functionality in SOCET SET. 
 
Another difference exists in the use of the attitude data ingested during image import. 
Although the BINGO Frame import module behaves in exactly the same manner as the 
Frame Import module, the input attitude values are applied in the sequence phi-omega-
kappa in the BINGO Frame sensor model instead of the usual omega-phi-kappa sequence 
in the Frame sensor model. Provided the attitude data are appropriate for the target sensor 
type, how the data is input into the two import modules should be the same from the 
point of view of the user. 
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3.1 Aerial Triangulation (SOCETSET-VR1-Bingo) 
 
Triangulation updates the Sensor Models of the images and uses a 
mathematical formula which models the relationship between Ground 
Space and Image Space. 
 

Overview 
 

Triangulation is a highly automated system for performing triangulation on a 
wide variety of image sources: 
 Large blocks of Frame Images 
 Satellite imagery (single or overlapped) 
 Stereo Image Pair 
 Combinations of Frame and non-Frame imagery 
 Imagery with or without initial support data 

Triangulation automates the tedious procedure of selecting and measuring the 
image coordinates of Pass Points, Tie Points , and Control Points . 
Triangulation automatically flags unacceptable tie points and displays the 
required images for remeasurement without your intervention. It also has the 
ability to automatically remove unacceptable tie points during the solve process. 
 
Triangulation executes the following major steps: 

 Setup 
 Tells Triangulation which images you wish to orient 
 The type of adjustment you wish to perform 
 The name of the ground point file you wish to use 
 The general layout of the image block 

 Automatic Point Measurement 
 Automatically or semi-automatically measure existing points as 

well as add new points to your chosen layout 
 Automatically measure points for relative orientation of strips or 

blocks of images 
 Measure across different scales and sensor types 
 Provides for automatically driving the extraction cursor to those 

points which require interactive measurement 
 Interactive Point Measurement 

 Measure control and tie points in any of the images participating 
in the triangulation. 

 Initialize/Solve 
 Provides blunder checking, relative, absolute, simultaneous, 

polynomial, and Direct Linear Transform (DLT) adjustments. 
 Initializes blocks of images that you imported without a priori 

camera model support data. After you solve the images, you 
must re-load them into the main image display. 

 
For frame camera imagery, you can start with image coordinates measured 
outside of SOCET SET. You can import plate coordinates. You can also import 
camera position and attitude data from programs such as ALBANY, PATB, or 
by entering this data manually. See “Frame and Panoramic,” Chapter 8 for 
more details. 
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Triangulation can also export data for use outside of SOCET SET. For example, 
you can export plate coordinates or model coordinates after measuring them with 
Triangulation. 

 
Triangulation registers images to the ground and to other images. Generally, 
most images need to be triangulated before you can perform accurate ground 
space measurements with the imagery. Triangulation is sometimes known by 
other names such as image registration, geopositioning, aerial triangulation, 
orientation, exterior orientation, and resection. 

 
The primary inputs to Triangulation are ground points and tie points. 

 Ground control points are identifiable objects in the image for which you 
have the precise ground space location (lat/long/elevation). 

 Tie points are points found in the overlap region of two or more images 
for which you do not have the ground space location. 

 
 
 
 
 
 
 
 
 
 
 
 
W
hen triangulating more than one image simultaneously, the images can come 
from a variety of sensors. For example, Triangulation can orient a SPOT image 
simultaneously with a frame camera image.After triangulation, images are said to 
be triangulated. Other words used for this are controlled, registered, solved, 
oriented, and georeferenced 
 
When to Use Triangulation 
Triangulation may not operate properly if images are rectified. For best results, 
perform Triangulation before Rec t i f i c a t ion. You should also run 
Triangulation before you can accurately perform image mensuration and data 
extraction. 

 For digital satellite-based imagery, you should run Triangulation 
immediately after importing your images. 

 For digitized film-based images, run Triangulation immediately after 
Interior Orientation. 

 If there is no support data available when you import the image(s), then 
you must run Triangulation before you can use the image for 
geopositioning. 

You can skip Triangulation if the sensor model support parameters provided at 
import time are sufficiently accurate. However, the support data provided with 
imagery is usually a mere estimate so if you skip Triangulation, poor stereo 
visualization and inaccurate geopositioning may result. Thus it is recommended 
that you run Triangulation even for images that have support data provided 
during the Import process. 
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If you import an image with an unknown sensor model, you should run 
Triangulation in the polynomial mode to create a sensor model for the image. See 
“Image Import/Reformat” on page 7-9 for importing images with unknown 
sensor models. 
 
After Triangulation, you can run the tools that require controlled imagery, such 
as Rectification, Automatic Terrain Extraction, Feature Extraction, Orthophoto, 
Mosaicking, and Coordinate Measurement. See “Workflow,” Chapter 3 for more 
details. You can run a few applications on uncontrolled imagery, such as 
Annotation (for making annotated screen dumps), Minification, and Image 
Export Reformatting. 
 
What to Name Images When Importing 
If you are going to triangulate a large block of imagery, you should use the 
Triangulation naming convention: ssss_iiii.sup, where ssss is the strip number 
and iiii is the image number. 
 
If you are working with a small number of images (a single image pair, for 
instance) you may use any names for the images.  
 
Triangulation uses the name of the support file to create names for automatically 
creating tie points. It does this by appending a decimal number to the support file 
name. If the support file name does not have an underscore in it, the decimal 
number is added without an intervening underscore. For example, if the support 
file name is “123.sup” a typical tie point name will be “1235”. If the support file 
name does have an underscore, another underscore will precede the decimal 
number. For example if the support file name is “1_1.sup”, a typical tie point 
name will be “1_1_7”. This allows you to control the tie point name to some 
extent and generate IDs which are all decimal numbers. 
 
Triangulation creates, updates, manipulates and uses the following  files. 
Triangulation File (.atf) 
This file contains a list of images that will participate in the triangulation. It also 
contains the necessary information to compute the initial estimates of the 
Triangulation parameters. Setup creates and populates this file. 
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Ground Point File (.gpf) 
This file contains the information about all ground coordinates of points involved 
in Triangulation such as control and tie points. This file is updated by Automatic 
Point Measurement (for tie points) and Interactive Point Measurement (for 
control points and tie points). You can create a Ground Point File containing just 
control points by running Interactive Point Measurement before you import any 
imagery. The residuals of each point are stored in the Ground Point File; the 
residuals are updated by Blunder Detection and Simultaneous Solve.  
Normally, you will use a single Ground Point File (.gpf) to control all images in 
your project. Each point in the file has a unique identifier called the Point ID for 
use throughout Triangulation. 
There are several ways to create the Ground Point File for your project: 

 Interactive Point Measurement provides a Review/Edit mode in which 
you can enter the ground control points regardless of whether you have 
imagery available. 

 Run Automatic Point Measurement 
 You can convert ASCII-formatted ground point files into the format that 

Triangulation expects by using ASCII Ground Point Import, as described 
in the Data Import/Export chapter. See “ASCII Image Point Import” on 
page 15-5 for details. 

 
Image Point Files (.ipf) 
Triangulation creates an Image Point File for each of the images participating in 
the triangulation. Each Image Point File has the same base name as the 
corresponding image file, but with a suffix of .ipf. The image point file contains 
the image point measurements and the point ID of the corresponding ground 
point from the Ground Point File. Automatic Point Measurement initially creates 
tie point data; Interactive Point Measurement creates and edits the ground control 
point data as well as tie points. This file is updated by Blunder Detect and 
Simultaneous Solve. If you somehow have points in IPF files which are not 
reflected in the GPF file, transfer them using the Reset > Transfer Image Points 
menu selection. 
 
Image Support Files (.sup) 
A single Support File exists for every image that participates in Triangulation. 
The ultimate goal of Triangulation is to build a support file that has accurate 
sensor model parameters. This file contains information for relating ground and 
image points via the sensor’s math model. This file is created during Image 
Import and updated by Exterior Initialize, Blunder Detection, and Simultaneous 
Solve. 
 
Image Files 
A single Image File exists for every image that participates in Triangulation. The 
file contains the pixel information for each image. This file is created during 
Image Import. 
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Constraint Files (.cns) 
When images share common exposure parameters these must be treated together 
and not adjusted as if they were independent. The constraint file defines which 
image parameters are shared between which images and allows the solution to 
adjust them in all shared images at once rather than independently for each image. 
GPS uses a constraint file. 
 
Automatic Point Measurement Strategy Files (.apm_strat) 
This file is used by Automatic Point Measurement (triangulation only) to guide 
the hierarchical matching algorithm. You must select one of the existing 
Automatic Point Measurement Strategy Files in the internal database. For 
Automatic point generation but manual point measurement, you can use the 
manual.apm_strat file. 

 
Solve Strategy Files (.solve) 
Contains flag values and parameter limits used by the Solve bundle adjustment 
operation. 

 
Tie Point Pattern File (.tpp) 
Automatic Point Measurement uses this file to control the placement and number 
of tie points. You can edit this file at will at the beginning of Automatic Point 
Measurement. 
Input File Bundle Measurement (images.meas) 
Contains image coordinate measurements. This file is used for Close Range 
Solve input. The file is generated from the File Export function. 

 
Object Coordinates (object.ini) 
Initial object coordinates, usually control points, used for Close Range Solve. 
The file is generated from the File Export function. 
 
GPS File (.gps) 
Contains accurate camera location data for each image at the moment of 
exposure and is used to define the support file math model. 

 
ASCII Ground Points (.agp) 
Contains the same information as the .gpf file of the same name. It also includes 
accuracy information for each point. The file is generated from the File Export 
function, and is designed specifically for use by Terrain Import. 
 
 
 
 
 
 
 
 
 
 
Each point takes up one line of text and is 
represented by eight fields: <point id> <x> 
<y> <z> <x-accuracy> <y-accuracy> <z-
accuracy> <point type>. The point id is an alphanumeric identifier that is unique 
to the point. x, y, and z are the point’s coordinates. The accuracy fields give the 
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standard deviation or error along the corresponding axis. The point type 
distinguishes among a Tie Points, Control Points, and Check Point. 
 
Graphical Attributes (.gra) 
Contains values to set the color, font size, font type, line size, and line thickness 
for each of the graphics types displayed during the triangulation process. These 
files are stored in the / internal_dbs/HATS directory and may be customized and 
stored under different names based on the user’s preferences. 
ocov file 
The .ocov file is a binary file containing the posteriori (after adjustment) variance 
of adjusted sensor model parameters and all types of ground points. It also 
contains the covariance between any pair of there parameters and ground points. 
Of course it contains the ID of these parameters and points as well. The specific 
parameters and points included in the .ocov file can be controlled 
by the user through the .cns file. 
 
Exporting Triangulation Information 
Triangulation can export information to several formats. Refer to the descriptions 
under the File menu for details. Some of these formats use the strip and image 
numbers created in Setup. If you have images in the sss_iii.sup naming 
convention and wish to preserve the strip and image numbers, be sure to use 
Auto Populate in Setup. This will make the strip and image numbers in the 
exported file match the support file names. 
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3.1.1 Preparation 
 
Before you can import or display imagery with the software, you must 
create a project. You can think of a project as a container holding the 
data for a set of images you are going to utilize. The data you extract 
from a set of imagery will be stored in the project directory that contains 
that set of imagery. When you create a project, you specify the 
coordinate system and datum to use for the project. You also will specify 
the disk directories of where the project and imagery data will be stored. 
Most importantly, you give your project a name. The name of the project 
file is the name you assigned to the project with the extension.prj when it 
was created. The software stores the definition of a project in a special 
project file. 
SOCET SET uses the computer file system to store its project data. The 
following figure depicts the directory tree the software uses to store its 
data. 
 
 
 
 
 
 
 
 
 
 
 
 
M
ost software applications require that you first load a project. Once you 
have loaded a project, you can then operate on the imagery and other 
data contained therein. You can import images into the project, 
triangulate the images, perform feature and terrain extraction, and create 
image products to export. The locations of the image files are defined by 
entities called Image Locations. 
 
You create a project by running Create/Edit Project, Initially, the project 
is empty; you populate it with imagery and other files when you run any 
of the Import applications (Image Import, Feature Import, etc.). After 
importing data, you will typically execute one or more extraction 
applications (Automatic Terrain Extraction, Feature Extraction, etc.). 
Next, build the products you desire (using applications such as 
Orthophoto or Image Map). Finally, you should archive the project using 
Backup and then delete the project with Delete. 

 
 

P
roj
ect Parameters 

The key constraint imposed by projects is that all data stored in a given 
project must conform to that project’s parameters. This means that all 
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data entry, data display, and imported data must conform to the project 
parameters. 
 
For example, if you create project XYZ and select the Geographic 
(lat/long) coordinate system with feet units, then you must enter all data 
(such as ground control points) as lat/long values, and all Z-units must be 
specified in feet. If you have any data in another coordinate system (e.g. 
UTM) you must convert it to lat/long before entering it into project XYZ. 
 
Every software project is characterized by the following parameters: 

 Coordinate System (Geographic or UTM or LSR or Grid/State 
Plane) 

 Horizontal Datum (WGS 84, NAD 27, etc.) 
 Units (feet vs. meters) 
 Vertical Reference (Ellipsoid vs. MSL) 

 
Additional parameters may be required dependent upon various 
selections. Once the project is created, the parameters you selected are 
displayed on the Main Menu window. 

 
Parameter Exceptions 
There are a few exceptions to this rule. For example, Coordinate 
Measurement allows you to display the extraction cursor location in 
several coordinate systems. Also, Triangulation allows you to enter 
ground control points in any datum. After you create a project, you may 
need to convert some of the project data to other coordinate systems or 
other units. To do this, use the Project Copy or Project Save As 
operations described later in this chapter. 

3.1.1.2 Creating folder and path/ directory for the image files 
 

1. Open Windows explorer and create new folder (e.g. 
ojt_photo) for the image files (e.g. 05_301). 
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2. Open “SOCET SET 5.3.0” Click ”Project”, select 
“Create/Edit Project” 

 
 
 
 
 
 
 
 
 
 
 

 
3. A “Create/ Edit Project dialog box will appear. Click 

the browse  button in the “Location “box. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
4. A “File Location” dialog box will appear. Click “Edit 

Locations”  button 
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5. A “location.list-WordPad” dialog box will appear. 
Type the directory (e.g. 
C:\SOCET_SET_5.3.0\images\ojt_photo). Then click 
“Save” . 
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3.1.1.3 Creating Project. 
 

You use Create/Edit Project to create your project. Since most 
SOCET SET applications require a project to be loaded, you 
must create a project before you can proceed with importing and 
extracting data. 

 
1. Click “File”, select “New”. 

 
 
 
 
 
 
 
 
 
 
 
 
 

2. Click the down arrow  in the “Coordinate System” 
box and select “Grid / State Plane”. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



IV-1-23 

3. A “Select a Coordinate System” dialog box will 
appear. Scroll down the arrow and select the desired 
coordinate system (e.g. Philippine_UTM_51N). Then 
click “OK”. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4.  Click the browse  button in the location box. A “File 
Location” dialog box will appear. Select the image file 
location [e.g. OJT_photo(192477)] Then click “OK” 

. 
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5. Type 0 in the “Minimum Ground Elevation 
(estimated) box and 2000 in the Maximum Ground 
Elevation (estimated) depending on the highest 
elevation of the project area. Click “File”, then click 
“Save”. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6. A “Project Name Selection” dialog box will appear. 
Type the desired project name (e.g. ojt_photo) in the 
“Enter Project Name” box. Then click “OK” 

. 
 
 
 
 
 
 
 
 
 
 

 

3.1.1.4 Camera Calibration 
 
The Camera Calibration Editor provides the means by which 

you enter and save frame camera calibration data. Calibration 
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data includes focal length, lens distortion, and principal point 
offset. 
 

It is also used for Triangulation using BINGO Frame images is 
the same as those for other types of images except that towards 
the end of the process the Solve Bingo button is activated for the 
block adjustment instead of the usual Solve button. See “BINGO 
Frame Import” on page 8-16 for details. 
 
Although this is true in general, there exist some subtle 
differences between these two processes. One involves the 
creation of the Camera Calibration file. For triangulation of 
BINGO Frame images, the Radius Unit must always be in 
millimeters, the Radius interval must be uniform, the Radius 
must be input in increasing order, and the Zero Radius must be 
included in the input Distortion table. 
 
You can edit an existing camera calibration file, or you can 
create a new one. The editor provides two ways for you to enter 
data: 

 A graphical drawing area that you click the mouse in. 
 Labelled text fields that you type data into with the 

keyboard. 
 
Your calibration data is saved in a camera calibration file with 
the .cam extension in the 
<install_path>/internal_dbs/CAM directory. 
 
To edit fiducial coordinates and distortion parameters, you have 
to bring up the Fiducial Coordinates and Distortion Parameters 
sub-windows, respectively. These sub-windows aredirectly 
accessible from the Camera Calibration Editor. 
 
The following steps are used to create a new camera file from 
the information contained in typical camera Calibration Report. 
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Autocollimatio
Symmetry 
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Fiducial position (numbering) depends on the type of camera 
(e.g. Zeiss RMKA) and location (e.g. Left Bottom, Left Top, 
Right top) of the aerial photo numbering 
 
 a) Left Bottom (LB) 
 

 
 
1. Click “Pr 
2.  
3.  
4.  
5.  
6.  
7.  

 
 
 
 
 
 
 
 
 
 
 
 
 

b) Right Top (RT) 
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1. Click “Preparation”, select “Camera Calibration”. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
2. A “Camera Calibration Editor” dialog box will appear. 

Click on the ellipse button  next to Camera 
Calibration File box. 
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3. Another “Camera Calibration Editor” dialog box will 
appear.  Type the camera calibration setting name (e.g. 
zeiss_rmka_15_23_LB.cam). Then click “Save” 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Location (e.g. Left Bottom) of the Photo Number 
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4.  Based on the camera setting parameters fill up all the 
boxes, Focal Length (152.977000), Autocollimation x 
(-0.005000) and y (-0.01000), Symmetry x (-
0.009000) and y (-0.001000). Then click “Fiducial 
Coordinates” button. 
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5. A “Fiducial Coordinates” dialog box will appear. This 
window consists of a large square drawing area and a 
list of fiducials. To add a fiducial point, position the 
mouse cursor over the approximate location of the 
fiducial within the camera frame. A numbered button 
will appear which represents the fiducial. At the same 
time, a corresponding entry (consisting of the ID 
number and coordinates) will appear in the fiducial list 
on the right side of the window. Note that the 
coordinate system origin is in the center of the 
drawing area. The units are in millimeters. Type the 
corresponding coordinates of each fiducial point. 
Click “OK”. Then click “Save”. 

 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Note: Create another camera calibration setting if the 
project has more than one aerial photo numbering 
position. 
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Right Top Numbering 
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3.1.2 Importing the Data  

3.1.2.1 Aerial Photo (TIFF file). 
 

SOCET SET can read strip, tiled, grayscale, palette color, or 
RGB TIFF images. Multiple band tiled TIFF is importable in 
either “chunky” or “planar” planar configuration. Strip-
formatted images must have uniformly sized and sequentially 
stored strips. Tiled JPEG, LZW, and Packbits compression are 
supported. 
 
If you create a one band TIFF image (“img_type_tiff”), it will 
have grayscale format (Photometric Interpretation = 0), except 
for creation by Image Map or Terrain Shaded Relief. When you 
select a pseudocolor output with Image Map or Terrain Shaded 
Relief, the TIFF image will have palette color (Photometric 
Interpretation = 3). If you create a multiple band image it will 
have RGB format (Photometric Interpretation = 2) and 
contiguous planar configuration (Planar Configuration = 1). All 
TIFF files you create will have big endian format. 
 
Tiled TIFF images (“img_type_tiff_tiled”) are created the same 
as regular TIFF, except tiling will be enabled. The tile size for 
output is fixed at 128. Multiple band images will be in “planar” 
format (PlanarConfiguration = 2). “Planar” format tiled images 
will read and display the fastest in SOCET SET. The 
PlanarConfiguration is irrelevant for single band images. 
 
Chunky tiled TIFF (“img_type_tiff_tiled_chunky”) are created 
the same as Tiled TIFF except they will have “chunky” planar 
configuration (PlanarConfiguration = 1) if they have multiple 
bands. This format is more common throughout image 
processing software packages for color imagery. 

 
TIFF tiled JPEG compressed (“img_type_tiff_tiled_jpeg”) are 
created the same as tiled TIFF except tiles are compressed with 
the JPEG algorithm. The tile size is fixed at 512. 

 
SOCET SET can also read and write from 8 to 16 bit per sample 
(two-byte) TIFF images. For reading, the bit depth is determined 
from the MaxSampleValue TIFF tag, if present. If this tag is not 
present, the BitsPerSample TIFF tag is used. To create two-byte 
data. select TIFF or TIFF Tiled format on any of the SOCET 
SET applications which write two-byte data as shown above. 
You can utilize TIFF files with multiple image pyramid levels 
within one file. In this case it is not necessary to minify the 
image, just perform an import and select the Support Only 
option. When the image is loaded into any application, the 
pyramid levels will be loaded automatically. To confirm which 
pyramid levels are in your image, import and load it into the 
Main Workstation Window and click on the minification level 
button. The pyramid levels available will be reflected there. If 
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you need to make smaller levels of minification to fill up the 
pyramid, run the image through Minification. 

 
 
 

1. Click “File”, select “Load Project”. 
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2. A “Select Project File” dialog box will appear. Select 
the project name (e.g. ojt_photo.prj) that was created. 
Then click “OK” . 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Click “Preparation”, select “Import”, select “Image” 
and then click “Frame”. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. A
 “Frame Import” dialog box will appear. Put mouse 
arrow inside the Input Images box and click right 
mouse button. Click the “Add” button. 
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5. A 
“Select one or more files to add” dialog box will 
appear. Use the down arrow  in the “Look in” box, 
browse and locate the image file (e.g. 06_517) to add. 
Then click “Open” . 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6. T
h
e selected image file will be reflected in the “Input 
Images” box. Check “Image and Support File”. Click 
the ellipse button next to “Location” box, a “File 
Location” dialog box will appear. Select 



IV-1-37 

“OJT_photo(192472.4MB) and click “OK”. Set 
Format to TIFF TILED, JPEG Quality to 90. Set 
Camera Calibration: zeiss_rmka_15_23_RT.cam Then 

click “Review/EditSettings” . 
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7. A “Review/ Edit Settings” dialog box will appear. 
Click the “Camera Position/ Orientation” tab, select 
the all the rows under the “Strip ID” column and 
Image ID Column, click right mouse button and click 
the ”Strip/Image ID from name” button. Click “Close“. 
Then Click “Start” . 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

3.1.2.2 Ground Control Points (ASCII). 
 
Ground Point Import reads ground point data in an ASCII format 
into the internal Ground Point File Format. The input ASCII file 
is restricted to one ground point per line. Each ground point 
contains a point ID along with an (X,Y,Z) coordinate. This 
information can be in any order, butit must all be on one 
line.Obtaining this window is as simple as clicking Preparation 
> Import >ASCII Ground Point Import on the main workstation. 
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Ground point control types of horizontal, 3-dimensional, and 
vertical are used within SOCET SET. Ground points which have 
a value of 0.0 exactly will cause the control point type setting to 
change. If your data has a control point of 0.0 0.0 3.2, the point 
type will be set to vertical (Z only). If your data has a value of 
2456.8 23778.9 0.0, the point type will be set to horizontal (X 
and Y only). 

 
You use ASCII Ground Point Import to translate and import 
ground point data from an external source into the native 
SOCET SET ground point file format. The units of the data can 
be either decimal for UTM, grid, LSR, or Geographic projects 
(see below), or degrees minutes seconds for any project. Degrees 
minutes seconds must be entered as “+-DD:MM:SS.SSS”. The 
presence of two colons is mandatory. When you create a 
Geographic project, you specify a preference for coordinate 
display. If you import a file with decimal numbers into a 
Geographic project whose display preference is “dd.dddd” the 
numbers will be interpreted as decimal degrees. For all other 
Geographic projects, decimal numbers will be interpreted as 
radians. 

 
 
 

Edit Input Format Option 
This window provides you with a way to specify the order of the 
information in the input file. Click Options > Edit Input Format 
on the ASCII Ground Point Import window. You can save this 
ordering in an input format file for later use with other ground 
point files. 
The Fields column on the right of the ASCII Ground Point 
Import window (above), indicates the current order. To change a 
field setting, select the desired format from Format Selection on 
the left. Then click on the appropriate field on the right.  
There are seven format settings from which to select: ID, X, Y, 
Z, Code, Ignore, and Illegal. 

 “Code” has no meaning for ASCII Ground Points. 
 “Ignore” is used to ignore any information that may be 

specified in a field. 
 “Illegal” indicates that a field should not contain any 

information. The entire point is discarded should any 
information be found in a field marked as “Illegal.” The 
following are some examples of legal settings for the 
input fields. 
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T
he GPS Ground Control Points file has several Field columns 
that need to be edited based on the seven Field column format 
settings (ID, X, Y, Z, Code, Ignore, and Illegal) being used in 
SOCETSET.  
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1. Open GPS Ground Control Points text file in Excel. 
Delete unnecessary field Columns. Then save file to 
*.csv format. 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2.  
Open csv file in notepad, edit format and save as text 
file. 
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3. Click “Preparation”, select “Import, and click “ASCII 
Ground Point”. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

4. An ASCIII Ground Control Point Import dialog box 
will appear. Click the browse button in the “Input File 
Format’” box. 
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5.  Another ASCIII Ground Control Point Import dialog 
box will appear. Select “Default.gcp”. Then click 
“Save”. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

6. Click the browse button in the “Input ASCII Ground 
Control Point File” box. 
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7. An “ASCIII Ground Control Point Import” dialog box 
will appear. Click the down arrow, browse and locate 
the directory where the gcp text file is located. Select 
the file (e.g. “ojt_xyz.txt”). Then click “Open”. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

8. Click “Options”, select “Edit Input Format”.  
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9. An “Edit Input Format” dialog box will appear. Select 
the settings in the “Format Selection” box the fields 
(e.g. ID, X, Y, Z) that were used in your gcp text file. 
Then click “OK”. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
10. Click “Options”, select “Set Accuracy”.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



IV-1-46 

11. A “Set Accuracy” dialog box will appear. Type “.3” in  
“X Accuracy” box, type “.3” in “Y” Accuracy” box, 
and type “.7” in “Z Accuracy” box. The values are the 
handheld GPS accuracy level in XYZ. Then click 
“OK”. 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 
12. Type output ground point file name (e.g. 

ojt_photo.gpf) in the “Output Ground Point File” box. 
Hit “Enter” in the keyboard. Then click “Start. 
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3.1.2.3 Using Control Point Editor 
 

Control Point Editor creates a file of control points, which are 
used by Triangulation. Use the Control Point Editor to create, 
view, edit, or change a file of control points. 

 
One of the important features of the Control Point Editor is that 
it lets you input the control point data in one coordinate system, 
and save the file in a different coordinate system. Selecting an 
alternative datum changes the display and input values. These 
are converted to/from the underlying project datum for storage in 
the .gpf file. This could be used, for example, when you have a 
pair of well-controlled images in a UTM project, but you want to 
collect control points for a State Plane project. 
The major capabilities of the Control Point Editor are as follows: 

 Creates a new ground point file or modifies an existing 
ground point file. 

 Saves the ground control points to the current project or a 
different project. 

 Converts the list of points to any project’s coordinate 
system and datum. 

 Measures (in three-dimensional space) ground points 
from controlled imagery. 

 Drives the extraction cursor to a three-dimensional 
ground point location for any point in the list. 

 Displays and accepts control point data in the current 
project’s coordinate system or an arbitrary coordinate 
system and datum. 

There are four ways to build a file of control points: 
 The Control Point Editor, 
 The Interactive Point Measurement window of 

Triangulation, 
 Ground Point Import, and 
 Coordinate Measurement Log. 

If you decide to use Control Point Editor for inputting your 
control points, you should run it after you create a project, but 
before running Triangulation. If you are going to use well-
controlled imagery (e.g. PPDB) to fabricate control points, you 
must import the well-controlled images before running Control 
Point Editor. 
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1. Click “Preparation”, select “Control Point Editor”. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. A “Control Point Editor” dialog box will appear. Click 
the browse button in the “Ground File” box. 
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3. A “Select Ground Point File” dialog box will appear. 
Click the down arrow button in the “Look in” box and 
locate the folder of the imported ground control point. 
Then click “Save”. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. The GCP point ID will be reflected in the Point ID 
box. Select one point ID (e.g. 319), the coordinates 
XY and elevation Z will be shown in the 
“Coordinates” box. Select the Leveling point ID (e.g. 
rm 14), click down arrow and select “Z Cntrl”. 
Change all “XYZ Cntrl” type of leveling point id to “Z 
Cntrl” 
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5. Click “File”, select “Save GPF”.  
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3.1.3 Interior Orientation  
 
Interior Orientation is a critical part of various import models. The units 
in film space are millimeters; the units in digitized image space are 
pixels. This transformation is a key part of the Frame and Panoramic 
sensor models. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The transformation created by Interior Orientation accounts for: 
 Resolution used by the scanner (dots per inch). 
 Film shrinkage or warping. 
 Orientation of the film when it was scanned. 
 The portion of the film that was scanned. 
 The position (offset) of the film on the scanner. 

 
Interior Orientation performs the following processing: 

 Provides you with the means by which you measure fiducial 
points or reseau marks. 

 Calculates Interior Orientation coefficients according to the user-
selected solution type. 

 Automatically updates the solution whenever you measure or re-
measure a point. 

 Stores the measured point data in the Interior Orientation point 
data file. 

 Stores the Interior Orientation coefficients in the image support 
file. 
 
 

When to Use Interior Orientation 
You normally perform Interior Orientation: 

 After importing your imagery with Frame or Panoramic Import 
 Before you perform Triangulation 
 Before the image is rectified 
 Before Automatic Point Measurement process 
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Interior Orientation is required for all images that have been created by 
scanning film. Interior Orientation is not required for non-film-based 
imagery such as SPOT or Landsat imagery. 
 
You may skip Interior Orientation if the Interior Orientation 
transformation is provided with the digitized image, in which case the 
system obtains the Interior Orientation information when you import 
your image. The Interior Orientation may also be skipped when 
employing special math models (for S2 and S3) since the .sup file is 
generated by using Topographic Engineering Center (TEC) translators 
on data block raster images prior to the orientation process. 

 
If Fiducials are Not Present 
If fiducial marks are not visible in the scanned imagery (because only a 
portion of the film was scanned, or because the film never had fiducial 
marks) then you should skip Interior Orientation. In this case, proceed 
directly to Triangulation and use a polynomial solution. 
 
Interior Orientation Data Flow 
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3.1.3.1 Automatic Interior Orientation (AIO) 
 
Interior Orientation can either be performed manually or 
automatically. Automatic Interior Orientation can be performed 
with multiple images at once either through the SOCET SET 
menu bar to pop up the AIO window, or in stand-alone batch 
mode. AIO updates the .iop and .sup with corrected 
measurements and generates a report file and a log file. If AIO 
fails, you can call Manual Interior Orientation by click the 
Manual IO button to measure fiducials. 
 
AIO supports the following camera types: 
 
 
 
 
 
 
 
 
 
To access AIO from within SOCET SET, click Preparation > 
Interior Orientation > Automatic Interior Orientation on the 
main workstation window 
 
 

1. Click “Preparation”, select “Interior Orientation” and 
click “Automatic Interior Orientation”.  
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2. An “Automatic Interior Orientation” dialog box will 
appear. Click “Add” button.  
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3. A “Select Support File” dialog box will appear. Select 
all the support file images (e.g. 05_301.sup, 
05_302.sup, 05_303.sup) to be used for interior 
orientation. Click “Open”. Then click “Start” 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. An “AIO” info box will appear. Click “OK”. 
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5. The RMS (pixel) result will be reflected in the 
“Result” tab. Check the RMS of those Image ID which 
has a value more than 0.35. Click “Manual IO”. 
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6. An “Interior Orientation” dialog box will appear. The 
fiducial point id 1 will be shown in the view window. 
Click “Locate All Fiducials and check the position of 
cross hair if it is in the center of the fiducial point. if 
yes, accept the RMS result, if not re-measure  by 
performing manual IO. 
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3.1.3.2 Manual Interior Orientation (IO) 
 

1.  Using the 3D stealth mouse, adjust the position of the 
cross hair near the center fiducial point. Click “Locate 

This Fiducial” . Click “Accept 

Sample”  and it will go to the next 
fiducial point ID. Repeat same procedure until all the 
fiducial marks have been measured.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



IV-1-59 

2. Verify RMS if it is approximately 0.35 or better 
(lower) Click “File”, select “Save”. 
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3. Click “Start” again. 
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4. Verify RMS results. 
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3.1.4 Observation of Photo-Coordinates (GCP, Pass Points, Tie  Points, 
& Leveling Points) 

 
 Measurement of Image Coordinates (Points) 

 
There are four ways to measure ground points in imagery: 

 Automatic Point Measurement (APM) (in Triangulation) 
 Interactive Point Measurement for APM 
 Interactive Point Measurement (IPM) for Blunder 

Detection 
 Interactive Point Measurement for Simultaneous Solve 

The decision of whether to run IPM before of after APM 
depends on the kind of ground points you have. The following 
table gives some guidance: 

 
WHAT TO RUN SITUATION 
 
APM before IPM   You have a few control points; and you 

want to Solve (after APM) before 
running IPM so that it is easier to find 
the control points in IPM. 

 
IPM before APM You measure some control points and 

some tie points in IPM (in one image 
only), then you run. APM to transfer 
these points to other images and to 
measure additional tie points. 

 
IPM only You have just one image. Or, you have 

lots of control points and you don’t 
need tie points. 

 
APM only You have no control points. To 

interactively review  the tie points 
measured by APM, you use IPM. 
Neither APM or IPM You have 
measured the image points on an 
analytical plotter, and imported them 
with ASCII Image Point Import, and 
are using Triangulation only for the 
Solve process. 

 
Control Points are points with known ground coordinates (XYZ, 
or XY, or Z). You must enter the location into the IPM window. 
Triangulation stores this data in the project Ground Point File. 
You must also use the extraction cursor to identify the control 
point in all the images in which the point is located. The image 
space positions are stored in the Image Point Files (IPF). 

  
Tie Points are points on the ground that you can identify in two 
or more overlapping images, but you don’t know the ground 
coordinate. You use the extraction cursor to identify the point in 
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all the overlapping images. The image locations are stored in the 
Image Point Files (IPF). An entry is created in the Ground Point 
File (GPF) for each tie point. APM will create tie points 
automatically. 

 
Check Points are points with known ground location (XYZ) that 
are not used in the solution, but are provided to help the operator 
perform a quality control check after the solution is complete. 
Check points are also called diagnostic points. 

 
Ground Point is an umbrella term that includes Control Points, 
Tie Points, and Check Points. 

 
Image points are the image space locations (in lines and sample                
coordinates) of Ground Points.  A single image point is stored 
for every instance of a ground point in an image. For example, if 
a tie point is located in 4 overlapping images, and you measure it 
in 3 of the images, then 3 image points are stored. Image points 
are stored in the IPF files. An image point must be associated 
with some ground point. If you somehow have points in IPF files 
which are not reflected in the GPF file, transfer them using the 
Reset > Transfer Image Points menu selection. 

 
Ground Point Selection  
Ground Point consists of two tables containing ground point 
information. The upper table lists all ground points in the current 
Ground Point File. Clicking the LMB on any point in the table 
moves the extraction cursor to that point and loads the measured 
and unmeasured images. 

 
Image Point Section 
This area contains the image status list which displays all images 
containing the selected ground point. The point status is either 
locked or unlocked, measured or unmeasured. An X in the 
appropriate field indicates locked or measured. The Master field 
indicates which images are loaded left or right. The left master 
image is always used as the master when Auto Two or Auto All 
is selected. 

3.1.4.1 Measuring GCP. 
  

1. Click “Preparation”, select “Multi-Sensor 
Triangulation”.  
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2. An “Automated Triangulation” dialog box will appear. 

Click the ellipse button. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



IV-1-65 

3. A “Save As” dialog box will appear.  Type a file name 
(e.g. ojt_photo) in the file name box. Click the “Save”. 
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4. The file name (e.g. ojt_photo) will be reflected in the 
triangulation file box. Click “Setup”. 
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5. A “Setup” dialog box will appear. Click “Add” 

.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6. A “Strip ID Sequence” box will appear. Type a 

number (e.g. 1). Then click “OK” . 
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7. A “Select Support File(s)” dialog box will appear. 
Select the images (e.g. 06_515, 06_516, 06_517) in 
the “Available” box. Click the arrow  to copy the 
selected image to the “Selected” box. Then click 

“OK” . 
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8. The created strip 1 will be reflected in the “Strips” box 
and the selected image (e.g. 06_515, 06_516, 06_517) 
will be reflected in the “Images” box.  Click “Reverse 
Order” of the images numbering. Refer to the flight 
index. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
9. C

lick “Add” under the “Strips” box. A “Strip ID 
Sequence” box will appear. Type the next number (e.g. 

2). Then click “OK” . 
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10. Select the next image corresponding to strip number 2. 
Click the arrow  to move the image to the 

“Selected” box. Then click “OK” . 
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11. Repeat steps 7and 8 until all the needed images have 

been selected. Click “Setup Block” . 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



IV-1-72 

12. A “Setup Block” dialog box will appear. Set “Mean 
Flying Ht.” to “6300”. And “Image Overlap Pct” to 70. 
Click “OK” . Then click “OK” 

. 
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13. Click ”Settings” and select “Enable Multi-Image 
Display.  
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14. Click ”Settings”, select “Graphic Display”. 
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15. A “Graphic Display” dialog box will appear. Check 
“Tie” box, “Control” box, “Icon” box, and “IDs” box. 
Click ”Apply” . Then click “Close” 

. 
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16.  Click ”Interactive Point Measurement”.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

17. An ”Interactive Point Measurement” dialog box will 
appear. Put arrow inside "Image Points" box, click 
right mouse button and select “Add”. 
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18. A “Select Image to Add” dialog box will appear. 
Select the needed images (e.g. 05_301, 05_302, 
05_303). Then click “OK”. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

19. Select a point ID (e.g. 203) in the “Interactive Point 
Measurement” dialog box. The position of the selected 
point ID will be identified on the image. Move the 
cursor if necessary to adjust the location of gcp on the 
position described from the description data sheet. 
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20. Once you have moved the cursor to the exact location, 
check the “Lock” box of the first Image ID (e.g. 
05_301). Click “Auto Two” button if the image point 
Id is within two or more images. Click “Save”.  
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21. Click the “Master” column of the next Image ID. 
Click right mouse button, select “Right”. 
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22. The selected image ID (e.g. 05_303) will move next to 
the first image ID (e.g. 05_301) Move the cursor if 
necessary to adjust the location of gcp on the position 
described from the description data sheet. Click “Auto 
Two” button if the image point Id is within two or 
more images. Click “Save”.  
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3.1.4.2 Measuring Tie Points. 
   

For tie points, the point measurement steps are similar except 
that the operator add the point ID and identifies the point 
location. 
 
Good tie point locations: 

 Flat Ground 
 No Vertical Obstacle 
 No Moving Cars 
 Good Image Contrast 

The tie point pattern represents an initial set of search locations 
that will be tested between each pair of overlapping images as 
APM proceeds. It is intended to give APM a hint on where to 
look for tie points, but does not indicate the final arrangement of 
points that APM will produce. The determining factors for 
selecting the arrangement of tie points are the amount and 
orientation of the overlap regions between images. 
 
In the simplest case of 60% forward lap and 30% side lap in a 
rectangular block, the standard 3x3 pattern can be used. This 
pattern directs APM to find three tie points along any of its sides. 
With 60% forward overlap the closest image will share six 
points with the first image, while the next image over will share 
three with the first. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Assuming the approximate math models are reasonable, APM 
should be able to find a sufficient number of points in this 
minimum case to allow a relative solution. However, in reality 
the approximate data may be inaccurate especially if the images 
were imported as “Unknown.” The effect of this is that the 
overlap areas will contain areas outside the pixel data and points 
will fail to correlate. In other cases, the overlap areas may be 
widely varied across or between strips—for some sensors these 
areas may be irregular polygons or just barely clip the edge of an 
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overlapping image making correlation, which requires a 15 to 
128 pixel “window,” impossible. 
 
One approach is to add many more tie point candidate locations 
distributed across each image, and try to measure as many points 
as possible regardless of the lap percentage and orientation. This 
results in many redundant points and many failed points. Using 
this “shotgun” approach trades computer processing time for 
manual editing and remeasurement time. Even if many points 
fail to measure, if enough have been measured to reach a 
solution, the failures can just be ignored without remeasurement. 
Care should be taken to insure that a “reasonable” distribution of 
successful points is achieved. Even if a large number of points 
fail, the remaining number are usually more than sufficient to 
allow reaching a solution. All points do not need to be measured 
before a solution can be executed. Unmeasured points are 
ignored by the solution algorithm. 
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1. In the “Interactive Point Measurement” dialog box, 
select the last point Id number, click right mouse 
button and select “Add”. Type the number of the tie 
point (e.g. 0651703)  
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2. Select the created tie point ID (e.g. 0651703), lock the 
first image ID (e.g. 06_517). Then measure the tie 
point base on good tie point location. Click “Auto 
Two”. Then click “Save”. 
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3. Click the “Master” column of the next Image ID 
(e.g.05_301) Click right mouse button, select “Right”. 
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4.  The image ID (e.g. 05_301) will be transferred next to 
first image ID (e.g. 06_517). Then measure the tie 
point. Click “Auto Two”. Then click “Save” 
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5. Select the next tie point in the point ID box and repeat 
steps 1-4 until all the needed tie points have been 
measured. 
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3.1.4.3 Measuring Leveling Points. 
 
 

1. In the “Interactive Point Measurement” dialog box, 
select the level point Id number (e.g. rm14). The 
position of the selected point ID will be identified on 
the image. Move the cursor if necessary to adjust the 
location of gcp on the position described from the 
description data sheet. 
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2. Select the created level point ID (e.g. rm18), lock the 
first image ID (e.g. 06_517). Then measure the tie 
point base on good tie point location. Click “Auto 
Two”. Then click “Save”. 
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3. Click the “Master” column of the next Image ID 
(e.g.05_301) Click right mouse button, select “Right”. 
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4. The image ID (e.g. 05_303) will be transferred next to 
first image ID (e.g. 5_301). Then measure the level 
point. Click “Auto Two”. Then click “Save” 
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5. Select the next level point in the point ID box and 
repeat Steps 1-4 until all the needed level points have 
been measured. 
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3.1.5 Calculation/ Inspection 
 

Simultaneous Solve. 
 
Simultaneous Solve performs a rigorous triangulation adjustment of a 
block of images to refine the estimates of their Triangulation parameters. 
Simultaneous Solve uses the weighted least squares method of 
adjustment in an iterative manner. It is capable of simultaneous 
adjustment of blocks of images taken by different sensors such as frame, 
panoramic, etc. It is also capable of recovering the interior geometry of 
the sensors via added parameters. 
 
Simultaneous Solve requires the following input: image coordinates of 
control and tie points and their accuracies (image point files), ground 
coordinates of control points and their accuracies (ground point file), 
estimates of Triangulation parameters and their accuracies (support files 
and Triangulation file), and the interior geometry of the sensors (support 
files). All these data are automatically accessed by Simultaneous Solve 
without your intervention. 
 
Simultaneous Solve uses a method known as “bundle adjustment” to 
determine the set of individual image parameter coefficients that 
minimizes the relative line/sample differences between points measured 
in overlapping images. The goal is to adjust the image parameters so that 
the position of a point in one image corresponds to the same point 
position in the other. If ground control is included, the parameters are 
adjusted so that the same image point corresponds to the same absolute 
position on all the overlapping images. 
 
The method constructs a matrix of the linear equations and iteratively 
adjusts each of the independent image parameters until the solution 
converges below a pre-defined acceptance threshold. There are generally 
two problems that can happen with Simultaneous Solve: failure to 
converge, and excessive RMS residual error. 

 
When you accept the solution, Simultaneous Solve will: 

 Update the residual fields in the Ground Point File. 
 Update the residual fields in each of the Image Point Files. 
 Update the sensor model parameters in each of the Image 

Support Files. 
 Write a Solution Accuracy Quality Report file (with 

extension .rep) in the project directory summarizing the image 
points, residuals, and solution quality. 

 Write a second, more detailed Accuracy Summary Data report 
<atffilename>.atf.utri_rep. This contains information on QA 
statistics not available under the regular solve bundle adjustment 
method. 

 
 

Excessive RMS residual error 
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The RMS of all the image residuals for the block is reported once 
convergence has been achieved. The acceptability of the RMS residual 
error depends on the sensor type and GSD but should be less than 1.0 
pixel in most cases. Values greater than this indicate that one or more 
points is mismeasured and is skewing the solution excessively.  
 
The Display Residuals menu can be selected to view the current image 
and ground residuals for all the measured points sorted by magnitude. 
Unfortunately, the largest residual points may or may not be the culprit 
in skewing the solution.  
The first strategy should be to turn off all control points and attempt a 
relative solution first, unless the bad tie point is obvious. 
 
If you examine a point with a high residual and it looks like it was well 
measured, you can skip it and try other points until you find one that is 
mismeasured. Examine points with even numbers of image overlaps over 
2 (4, 6) and check the points between the first, third, fifth, etc. images to 
make sure that the point is measured at the same location. 
 
Also, move and remeasure points which are on rooftops or in trees. Trees 
tend to move somewhat in windy conditions, or are difficult to measure 
accurately and distort the solution when used for tie point locations. 
 
It is recommended that solutions with excessive RMS error should be 
discarded and not Saved. It is likely that the resulting math models are 
degenerate, or at least worse than the existing approximate math model. 
If the relative solution (control points OFF) shows good RMS error 
results, the math model can be Saved and the control points can be later 
remeasured. Usually the problem is not the measurement but the absolute 
ground position specified for the point. You should confirm from the 
original hardcopy control database, or other sources, that you have the 
right coordinates for the right image point, and that the elevation data is 
consistent with the project units (feet vs. meters, MSL vs. Ellipsoid) as 
specified. 
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1. After measuring all the needed control points, click 
“Solve” in the “Automated Triangulation” dialog box. 
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2. A “Simultaneous Solve” dialog box will appear.  Click 
“Start” . 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

RMS (Image Pixel-0.433) is less than 1.0 pixel. 
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3.1.6 Product 
 

Stereo model with all the measured photo control points (GCP, Tie Point, 
Level Point) 
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